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QTP MOCK TESTQTP MOCK TEST

This section presents you various set of Mock Tests related to QTP Framework. You can download
these sample mock tests at your local machine and solve offline at your convenience. Every mock
test is supplied with a mock test key to let you verify the final score and grade yourself.

QTP MOCK TEST IIQTP MOCK TEST II

Q 1 - How can you add recordable or non-recordable operations to your test?

1. Use the Step Generator

2. Insert through Keyword View.

3. Drag objects from Available Keywords.

4. Drag objects from the Data Table.

A - 1 2 and 3 only

B - 3 and 4 Only

C - 1 2 and3 Only

D - All 1 2 3 and 4

Q 2 - What is a UFT test comprised of?

A - calls to actions

B - calls to actions reusableonly

C - calls to QuickTest Professional tests

D - calls and copies of actions

Q 3 - Which names are used to identify the status of your application before and after
your automated test executes?

1. initial condition

2. static state

3. end condition
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4. done condition

A - 1 2 and 3 only

B - 3 Only

C - 1 and3 Only

D - All 1 2 3 and 4

Q 4 - During the planning phase, you decide to create multiple actions that can be
combined and reused to achieve testing goals. Which element is critical for identifying
the actions to be recorded and how to combine them?

A -input data

B - parameters

C -initial and end conditions

D -visual cue

Q 5 - What are the default add-ins checked for installation in UFT

1. .NET

2. ActiveX

3. HTML

4. Web

5. Java

6. Visual Basic

A - 1 3 and 4 only

B - 2 4 and 6 Only

C - 1 and4 Only

D - All 1 2 3 and 5

Q 6 - Which UFT View Option will show you the repositories associated with each
action?

1. Resources

2. Information

3. Script Repository

4. Active Screen

A - 1 2 and 3 only

B - 1 Only

C - 1 and3 Only

D - All 1 2 3 and 4



Q 7 - Where can you reset the add-in manager if it does not display when you launch
UFT?

A - General Options

B - Run Options

C - Test Properties

D - Test Settings

Q 8 - You set your Record and Run settings to 'Record and run test on any open
browser'. Which applications will be recorded?

1. Firefox

2. Safari

3. Opera

4. Chrome

5. Internet Explorer

A - 1 4 and 5 only

B - 5 Only

C - 1 and 5 Only

D - All 1 2 3 4 and 5

Q 9 - Which directory is the default directory in the UFT file structure where the local
Data Table is located ?

A - Action 0 folder

B - Local Action folder

C - Default Test folder

D - Data folder

Q 10 - Which UFT menu item should you use when emailing a UFT test to another
tester?

A - Send Email

B - Export Test and Email

C - Save Test with Resources

D - Export Test to Zip File

Q 11 - You have defined a global synchronization timeout of 30 seconds for your test.
The synchronization point timeout for a button to become enabled is set to 10000.
During playback of the script, what is the maximum amount of time UFT will wait for
the button to become enabled?



A - 10 seconds

B - 30 seconds

C - 40 seconds

D -10030 seconds

Q 12 - How does UFT identify each object you record ?

A - by class and properties

B - by class and methods

C - by methods and properties

D - by class only

Q 13 - Which UFT feature should you use to view methods and properties of objects in
your application?

A - Spy Object

B - Object Repository

C - Object Spy

D - Object Viewer

Q 14 - Which object repository type is created by default ?

1. shared

2. reusable

3. local

4. global

A - 1 2 and 3 only

B - 3 Only

C - 1 and3 Only

D - All 1 2 3 and 4

Q 15 - You need to change the properties of an object in your object repository. Which
repository feature enables you to quickly access the specific item if your repository
contains hundreds of objects?

A - Highlight in Application

B - Search in Repository

C - Identify in Repository

D - Locate in Repository



Q 16 - Which step categories can be added using the Step Generator Tool ?

1. run-time objects

2. default object types

3. test objects

4. utility objects

5. data objects

6. Functions

A - 1 3 and 5 only

B - 2 4 and 6 Only

C - 1 5 and6 Only

D - 3 4 and 6

Q 17 - Which UFT feature confirms that the application is functioning correctly?

A - parameterization

B - checkpoint

C - breakpoint

D - validation

Q 18 - Which statement type can you use in your test to wait for a condition to be met
and fail the test if it times out before meeting the condition?

A - pause method

B - exist method

C - standard checkpoint

D - wait statement

Q 19 - Which Checkpoint validate the image color.

A - Standard

B - Bitmap

C - Page

D - Picture

Q 20 - Which checkpoint type should you use to validate the enabled state of a
button?

A - text

B - enabled

C - standard



D - XML

Q 21 - Which term is used to define a string of special characters that define the
condition of the search?

A - constant expression

B - regular expression

C - placeholder

D - parameter

Q 22 - Where is data for an input parameter stored?

A - run-time Data Table

B - design-time Data Table

C - run-time Data Repository

D - design-time Data Repository

Q 23 - User-defined environment variables can be imported from an external file. What
is the valid file type that can be imported?

A - txt

B - xml

C - csv

D - html

Q 24 - After playing back a test containing output values, where can the output values
be viewed?

A -global Data Table

B - local Data Table

C -design-time Data Table

D -run-time Data Table

Q 25 - How can the Data Table be used in a custom checkpoint?

1. to store output values

2. to use formulas

3. to access global values

4. to compare columns

A - 1 and 3 only

B - 2 and 4 Only



C - 2 and 3 only

D - 1 and 4 only

Q 26 - Which checkpoint type uses a query to validate expected value?

A - standard

B - table

C - database

D - SQL Checkpoint

Q 27 - What is compared in a bitmap checkpoint?

1. bits

2. RGB

3. pixels

4. text

5. jpegs

A - 1 2 and 3 only

B - 3 Only

C - 4 and5 Only

D - 1 3 and 5

Q 28 - Which bitmap checkpoint feature allows the checkpoint to pass even if bitmaps
are not identical?

A - bit tolerance

B - RGB tolerance

C - BW tolerance

D - image tolerance

Q 29 - Which status is reported in the Test Results Summary if the test does not
include checkpoints?

A - Fail

B - Passed

C - Done

D - Complete

Q 30 - You ran a test scenario with 10 iterations. What does the Test Results Summary
report if 8 iterations pass and 2 iterations fail?



A - The summary reports PASS because more iterations passed than failed

B - The summary reports the status for each iteration

C - The summary reports DONE

D - The summary reports FAIL because all iterations did not pass

Q 31 - A tester uses UFT connected to Quality Center ALM and the tests are stored in
ALM. At an upcoming conference, this tester wants to demonstrate a new UFT test.
The test makes calls to reusable actions from other QuickTest Professional tests
stored in Quality Center. What is the simplest way to make the test portable so it can
run disconnected from Quality Center?

A - Use the QuickTest Professional Save test with resources feature.

B - Change the calls to the reusable actions, use copies of the reusable actions, and then use the
QuickTest Professional Save test with resources feature.

C - Use the QuickTest Professional Save test with resources feature for main test and do the same
for the test that contains the called reusable actions.

D - Use the QuickTest Professional Export to zip feature.

Q 32 - What happens when a tester performs an Insert > Call to Copy of Action?

A - The local Data Table and the run iterations settings inactioncallproperties are copied over.

B - The steps, checkpoints, parameterizations, action parameters, and object repository are all
copied over.

C - Only the called action, but none of its child actions thatis, actionscalledbyit, is copied over.

D - The Use data stored with the original action is disabled.

Q 33 - Which feature displays all the test's actions ?

A - Actions tree within the Resources panel

B - Test Flow panel

C - Flow Viewer panel

D - Test Action Manager Tool

Q 34 - Where are the local data sheet iterations specified ?

A - Test Run Properties/a>

B - Action Settings

C - Action Call Properties

D - Test Flow Settings

Q 35 - When inserting a call to a reusable action, how are the data resources in that
action handled?



A - The data continues to be stored with the original action read − only and the new action refers to
it.

B - A copy of the data is made editable and stored with the new action.

C - The tester must make a one-time selection to either copy the data or refer to the original
data.

D - The tester always has the option to copy the data or refer to the original data.

Q 36 - Where do you go to modify a shared object repository?

A - Resources > Object Repository Manager

B - Resources > Object Repository

C - Tools > Object Repository Manager

D - Tools > Resources Manager > Object Repository

Q 37 - Which UFT tool uses the Object Repositories Merge Tool?

A - Map Repository Parameters Tool

B - Update from Local Repository Tool

C - Object Repository Comparison Tool

D - Update from Application Tool

Q 38 - Which conflicts does the Objects Repositories Merge Tool detect? Selectthree

1. same object different parent

2. same name different description

3. same description different name

4. same name extra properties

5. similar description

A - 1 2 and 3 only

B - 1 4 and 5 Only

C - 1 2 and 4 Only

D - 2 3 and 5

Q 39 - Which steps are required to connect to ALM from UFT? Selectthree.

1. define a project

2. connect to the server

3. authenticate user

4. create a user

5. define a domain



6. select a project

A - 2 3 and 4

B - 1 2 and 3

C - 2 3 and 6

D - 2 3 and 5

Q 40 - Which feature requires a connection to ALM?

1. Version Control

2. Jump to Step

3. System Monitor

4. Save Test with Resources

A - 1 2 and 3 only

B - 3 Only

C - 1 Only

D - All 1 2 3 and 4

Q 41 - Identify UFT resources. Selectthree.

1. test versions

2. actions

3. checkpoints

4. function libraries

5. images

6. recovery scenarios

A - 1 2 and 3 only

B - 2(3 and 4 Only

C - 4 5 and 6 Only

D - 2 4 and 6 only

Q 42 - Which menu option should you use to save your test to a version controlled
ALM/QC project for the first time?

A - Check-in

B - Save As

C - Save Test with Resources

D - Create Version



Q 43 - Which Recording mode records mouse and keyboard operations.

A - Analog

B - Low

C - Normal

D - Insight

Q 44 - Which feature can you use to teach UFT to recognize any area of your
application

A - object identification

B - object wizard

C - virtual objects

D - virtual identification

Q 45 - You are creating a recovery scenario to handle a pop-up message box with OK
Button. Which recovery option should you select?

A - Keyboard or mouse operation

B - Close application process

C - Function call

D - Restart Microsoft Windows

Q 46 - How can you pause and interact with the playback of a test?

A - Add a wait statement.

B - Add a breakpoint.

C - Add a delay.

D - Add a stop point.

Q 47 - Which tab in the Debug Viewer pane allows you to view or change variables or
properties?

A - Watch

B - Variables

C - Command

D - View

Q 48 - Which Settings tab enables UFT to measure the resources being used by the
application?

A - Resources

B - Environment



C - Local System Monitor

D - Run

Q 49 - How can you use monitors to cause the test to fail?

A - Add a monitor checkpoint.

B - Add custom code to evaluate monitor data.

C - Define a counter scale.

D - Define a monitor limit.

Q 50 - What can you do using the To Do pane? Selecttwo.

1. Assign tasks to others.

2. Mark a task as In progress.

3. View TODO comments existing in the current test recovery scenarios.

4. Export TODO comments to comma-separated values or XML format.

5. View TODO comments existing in the current test checkpoints.

A - 1 and 2 only

B - 3 and 4 Only

C - 4 and 5 Only

D - 1 and 4 Only
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Question Number Answer Key

1 C

2 A

3 C

4 C

5 B

6 B

7 A

8 C

9 C

10 D

11 C

12 A



13 C

14 B

15 D

16 D

17 B

18 C

19 B

20 C

21 B

22 B

23 B

24 D

25 A

26 C

27 B

28 B

29 C

30 B

31 A

32 B

33 B

34 C

35 D

36 A

37 B

38 D

39 C

40 C

41 D

42 B

43 A

44 C

45 A

46 B

47 A



48 C

49 D

50 D
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